Excel 2013: Business Spreadsheets

Legs, Eggs and Pigs in a Basket

Intermediate Excel Objectives

In this lesson, you will learn how to: D2 i X v A =C2*D2
1. Format data and content.
2. Fill a series with AutoFill. R , B8 | ¢ | b | E
3. Calculate revenue with a formula. 1 |Date Product = Net _Quantity Revenue
4. Summarize the data. 2| Julyi,2013Eggs | $ 150§ 100j=co+D2 |
5. Identify Relative References. 3 | July2, 2013 Eggs S 150 105
6. Identify errors and troubleshoot 4 | July3, 2013 Eggs S 150 110
equations. 5 | July4,2013 Eggs S 150 115
7. Use the Auditing Toolbar. 6 | Julys, 2013 Eggs $ 150 120
7 | Julys, 2013 Eggs $  1.50 125
€28
c2 | i | x & || =Legs!E2+Eggs!E2+PigsIE2
| A | B | C l D [ - | F
1 Date Product Revenue

2 July 1, 2013 All Productsl 51,262.50 I
3 July 2, 2013 All Products  $1,291.00

© 2013 Comma Productions, LLC
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1. Readings
Read Lesson 1 in the Intermediate Excel
guide, page 11-48.

Project

A spreadsheet that calculates the daily sales for
three products and adds up the total on a
summary spreadsheet.

Downloads
Legs Eggs Pigs 2013.xIsx

2. Practice
Complete the Practice Activity on page 49.

3. Assessment
Review the Test questions on page 50.

Lesson 1: Legs, Eggs and Pigs in a Basket

Home
] — 2 A
. - = utoSurr
|Currenq,r | = i :} A %( [ | | kil
$ - 9% |{T:ig 0o | Conditional Formatas  Cell Insert Delete Format
S & Clear~

Formatting~ Table~ Styles~ = = =

Number Styles

Cells
Formulas i] i] 1]
:5 Trace Precedents %] Show Formulas m
oo
Watch
Window

858

j
Af2]
N :=] Define Name ~
“iETrace Dependents I Error Checking -

I& Remowve Arrows = @ Evaluate Formula

?'L Use in Formula
Mame
Manager |'E|I Create from Selection

Defined Mames Formula Auditing

T
Menu Maps 8 7] |

This lesson show options on the Home and Formulas
1. Home->Number->Date, page 15

. Home->Number->Format Cells, page 17

. Home->Editing->AutoSum, page 24

. Home->Cells->Format, page 27

. Home->Cells->Delete, page 29

. Formulas -> Formula Auditing->Trace Dependents, page 41
. Formulas -> Formula Auditing->Trace Precedents, page 42
. Formulas -> Formula Auditing->Show Formulas, page 44

. Formulas -> Formula Auditing->Error Checking, page 46

O©COoONOO AP WN
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Calculating Sales

Our little online farmer’s market is growing. Supply can hardly keep up with demand at Charlotte’s Web Site. We're counting the
chickens before they are hatched. Is there a way to forecast what we might sell, say Wednesday two weeks from now? Yes,
there is. We can set up a spreadsheet that will calculate our sales on any given day.

Start Microsoft Excel. When the Welcome screen appears, open a new, blank workbook.

What do you see from the top of the screen? Is there a Home Ribbon? And the Insert, Page Layout, Formulas, Data. Review
and View Ribbons as well? Yes. Then you are ready to get started.

FILE HOME IMNSERT PAGE LAYOUT FORMULAS DATA REVIEW VIEW

db Cut Calibri A A== 2 | 5o Wap Ted
= ER Copy -
aste o || M o = -l === | & a=
~ Format Painter B I U - & = - - — 7= = Merge&
Clipboard Ta Font a Alignment
Al | i S
A B C D E F G H

L9, I S T B LN B
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Opg Home -> Font -> Bold
Enter the Labels [ % "l“‘ ';““ i — Bt - Rst ol I..__,;..a.,-qlx
Hello, Excel. There are only three - X e P T T | ) B ) [ ae g
parts to a spreadsheet: labels, data, il IR E R Y | Bl ot < | 5 % o | _-_—__*--;-;: et o ot T o
and formulas. Start with the labels. ==— o ke ' i e o T o bimg . 1
A & L] £ -] L} L] 4 H L] Ll L b L] L] o L] (-] ] % T L]
1. Try This: Enter the Labels R
Click on Cell A1 and type: Date :
In Cell B1 type: Product :
In Cell C1 type: Net :
In Cell D1 type: Quantity 5
In Cell E1 type: Revenue 1
If these are labels--and they are-- :.
select Row 1 and make them Bold. u Al i x v A Date
Keep going... ;] 4 A B C D E F
- 1 |Date Product MNet Quantity Revenue

2—

3—

4_

5_

E—

7

Exam 77-420 Microsoft Excel 2013
2. Create Cells and Ranges
2.2 Format Cells and Ranges: Change Font and Font Styles
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Enter the Date

2. Try This: Enter the Date

Select Cell A2 and type: July 1, 2013.
Click ENTER on the keyboard.

What Do You See? The date in Cell A2 is
displayed as 1-Jul-13. This is a default date
format: d/mml/yy.

Keep going...

Home -> Number

BE s+ Booa™ - sl L & %
Bl - o oo smad tau mew e sz ot +
T O N ®PEFDI- A
o .I'H.-ul.-n.- "Iy- -| - - A Bl et -} - W o 5 *?IP"-P'"!_-'::F G | bt D b | ::5;-

v “ Famt e e e [y [ -
Ay = & | HaEu =
A& [ 5 [} L P L] H ) ] L [} L' L] a L a L] 1] ¥
1.0 et Fnaamlfy e
T
]

:
4y
]
1
'
L)
A R, 7/1/2013
A B ¢ D | E | F
Date Product Met Quantity Revenue
1-Jul-13|
[

Exam 77-420 Microsoft Excel 2013
2. Create Cells and Ranges
2.2 Format Cells and Ranges: Apply Number Formats
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Ong Home -> Number ->Number Format
LR Bomd ) - Raxed ¥ = A %
Format Date and Time M= 0 = = = = = L i R
Many companies work with people from -l P T T O T | Bl bt <[ § - % 0 [ 8 o e VE e Do Pt | 3
around the world. When you select a S = . - e s | I 3 ll
format that displays the names of the A - A BT —
months, it makes it clear whether 2/1/14 S 1 ¢t .ttt s b ABC General [~
is Januar_y 2nd or February 1st. I?Iease :[@] 123 1o specific format
format this column for date and time. 4
: l 2 Number
; Date
[ate - =
a @Fg Currency
$-9% » | %0 5% . == Date
-
MNumber ) 5 " Accounting
- !_lgg—gﬁﬁ Date
n
3. Try This: Change The Date Format .
Select Column A, first. ~ | A2 B fe | 7/1/2013 tEEH  Short Date
Go to Home->Number. I Date
Go to Number Format. A ] C D E
The default number format is General. ! ! — E Long Date
Select: Long Date. Date Product Net Quantity Revenue [ Date

Monday, July 1, 2013

Keep going...

Memo to Self: Column A may resize
automatically to fit the date. If you see
##H### that means the Column is too
narrow. Please make the Column wider.

Exam 77-420 Microsoft Excel 2013
2. Create Cells and Ranges
2.2 Format Cells and Ranges: Apply Number Formats (Date)
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Format Cells
4. Try This, Too: Find Custom Date Formats

There are additional formats in the Number Group.

These options can be found by clicking on the
Option arrow in the lower right corner.

| Date - |

.0 .00
$ - O 9 | T
Mumber P

What Do You See? There are several pages of
formatting options.

Go to the Number page and select Date

Select a Type: March 14, 2012.

This is a Medium Date Format.

Click OK.

Keep going...

Memo to Self: You can create a Custom format if

you wish. We will use this option in a different
lesson a few pages down the road.

Home -> Number ->Number Format

Lategory:

General
Mumber
Currency

ﬁu:muntini

Time
Percentage
Fraction
Scientific
Text
Special
Custom

! Mlignment | Font | Border | Fill | Protection

Sample
Date

Type:

*3/14/2012

“Wednesday March
314

31412

031412

14-Mar

14-Mar-12

Locale (location:
English [United Stat

Date formats display date and time serial numk
an asterisk [*) respond to changes in regional date and time seftings that are specified for the
operating system, Formats without an asterisk are not affected by operating system settings.

Exam 77-428 Microsoft Excel 2013 EXPERT

2. Apply Custom Formats and Layouts

Category:

General
MNumber
Currency

Accountin i

Time
Percentage
Fraction
Scientific
Text
Special
Custom

2.1 Apply Custom Data Formats: Advanced Fill Series Options

Intermediate Microsoft Excel 2013 Page 17 of 245

Sample

Type:

March-12
March 14, 2012
31412 1:30 PM
31412 13:30
it

M-12
31452012
Locale (location):

English [United States)




r""&

What Do You See? The dates will increment (add

| July1, 2ﬂ13_| -‘__

One Home -> Number ->Format Cells
LR - ot - s g o
Fill a Series with AutoFill il =y Ty ——— e e e ——
Now, one way to put in the dates for the next month v 2 e u-|Ee 24 [ P cooems (7t o |t Dot T b b
would be to type them all. Do you want to know a faster cvases o : saqraret LS oo ) 5
way? AutoFill is a quick method for filling in data. It is *-‘ i £ | Shah
not quite the same as copy and paste. T ——— S S P S —— — — — —
Hie
4 | wiya 3ma
5. Try This: Use The AutoFill AT
Please select Cell A2, first. 1| -naau
Look at the bottom right corner of Cell A2. e
The AutoFill Handle is a small square. When you run | Ay
your mouse over the Handle, your mouse will become a 3|50 A2 - fe 7/1/2013
thin black cross. b e n
i
Hold the AutoFill handle and drag down to Row 24. :-': EEE = : L = L B L E L F
u Date Product Net Quantity Revenue
M
9

another day to each Row) as you Fill Down Cell A2.

Keep going...

AutoFill Handle

July 21, 2013
July 22, 2013

July 23, 2013
=i

Exam 77-420 Microsoft Excel 2013
2. Create Cells and Ranges
2.1 Insert Data In Cells and Ranges: Autofill

Intermediate Microsoft Excel 2013
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T
onre AutoFill Options

S ] [ Bout’ - nn Ol a n
AutoFill Options e e gy e e e e
What Else Do You See? Look by the AutoFill o e e [V T e [E & L T e s G | o T pei
handle in Cell A24. There is a little option box that : = : s . e o o 6
you can click. The AutoFill Options are: A
Copy Ce"s i L} ' L] L & ) L3 L w L] 2 L o L L] T
Fill Series .
Fill Formatting Only :
Fill Without Formatting "
Fill Days u
Fill Weekdays » July 16, 2013
Fill Months n July 17, 2013
Fill Years L 2 Copy Cells
Flash Fill " - July 18, 2013 Py €

ol e == 16| July19,2013| O Fill eries

| by L N Fa——
The Day, Month and Year formatting displays L — 17| July 22, 2013| ©  Fill Eormatting Only
only that portion of the date that you entered in the 2 [ 8 12| Julv 23 2013 ) i ]
Cells. You can choose to Fill the Cells with or = uly £3, O Fill Without Formatting
without the Cell Formatting, too. . 19| July 24, 2013 O Fill Days

| 201 July 25, 2013 :
Fill Weekdays looks up the dates in your Series 21| Julv 26. 2013 | Fill Weekdays
and enters only the days from Monday to Friday. Y <0, O Fill Months
No weekends-sweet. 22| July 23, 2013 -
0 Fill Years
6. Try This, Now: Fill the Weekdays I i R ,
Click on the AutoFill Options. 24| July31,2013] © ElashFill
ﬁelect: FjllWeekdays. 25 =
eep going... E
26 | =
2?_

Exam 77-428 Microsoft Excel 2013 EXPERT
2. Apply Custom Formats and Layouts

2.1 Apply Custom Data Format: Use Advanced Fill Series Options
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onre AutoFill Options

Copy the Data with AutoFill R ——— e i

Charlotte’s Website sells eggs, chicken wings, and b e e | B T |- 2 042 | E b < | § - % 0 |1 | G fomsi ot | e Gk fomat | D et Pt

little sausages wrapped in pastry. Eggs, Legs, and Cotaes L] : erarmt L - tort toums

Pigs in a Basket. AutoFill works here, as well. L . £ | e ?
i L H (-] L (] L L

7. Try This, Too: Copy a Series

Select Cell B2 and type: Eggs.

Now, click once on Cell B2 to select it.
Double click the AutoFill handle on Cell B2.

What Do You See? AutoFill copies the word Eggs
and fills all the way down to Row 24.

Look Again: AutoFill copied the data down as far
as the column to the left. So don’t worry, it won’t go
on beyond Cell B24.

TEIRRRaRaaaaaaaaanee:|

il fe || Eggs

B C D E F

Date Product MNet Quantity Revenue
July 1, 2013|Eggs l

1

2

3 | July2,2013

4 | July3,2013 ‘\
5

6

7

Keep going...

| July4,2013 AutoFill Handle
July 5, 2013

July 8, 2013

Exam 77-420 Microsoft Excel 2013
2. Create Cells and Ranges
2.1 Insert Data In Cells and Ranges: Autofill
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Ong Home -> Number ->Number Format
IS oo™ - sl bW & %
Edit and Format the Money R e x| mele. e | ] B 3B (S Tty s =
Say the net profit on a dozen eggs is $1.50 b o (n v u-|E-EA- [ P— e e = =
after shipping and handling. Pretend these are Ouaaies = sapae m— v o oy =
gourmet eggs, sold on the Internet. You don’t “ £l 8
need to type the dollar sign. We're going to T ‘____ﬂj,,,r — ! 2 £ : Beoo®= 2 = ' :
format the Column for currency. e
i ..l.lx;uu_-\ % 1
8| miidivipn [ § 18
8. Try This: Enter the Data Bl e [N
Select Cell C2 and type: 1.50. B e
M| ahylLmiiipe |5 LS
M| syiimirige (B RS
Try This, Too: Format the Cells i R
Select Column C. H e
Go to Home->Number. s s e .': AN
Select Accounting (dollar sign) from the 8]~y e I: im
Number Formats. Accounting formats the Cells | =i |2 1o
so the dollars and cents line up. il
3| ss
And Try This: AutoFill the Data o | C2 h J 1.5
Select Cell C3 and AutoFill the $1.50 by !
double clicking on the little square handle. I B C > E
What Do You See? The money should be 1 Date Product | Net Quantity Revenue
copied all the way down to Cell C24. 2 | Julyl,2013 Eggs S 150
, 3| July2, 2013 Eggs $ 150
Keep going, please...
4 | July3, 2013 Eggs 5 150
5| July4, 2013 Eggs $ 150
6 | Julys, 2013 Eggs 5 150
7| Julys, 2013 Eggs $ 150

Exam 77-420 Microsoft Excel 2013
2. Create Cells and Ranges
2.2 Format Cells and Ranges: Apply Number Formats
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Ong AutoFill Options
NS ' oo™ -Usanl PO 8 %
AutoFill a Series T O N L T T
This little web site sells about 100 egg i T T O T P [~ TP P x:m;;; el Lol T 9
baskets a day. Suppose we sold another 5 Donaws - s — taser 2 Lo =
baskets every day. What would the sales . A ]
revenue be? : ml' w:..l.. :..‘”—L_,,....,___w....'_ S T S S S S S R R N
B rely LU B § LW :l-
9. Try This: Enter the Data Bl imne 5 1 [EEEE
In Cell D2 type 100. Bl e 3 ool
In Cell D3 type 105. B i 5 |l
M| sy 11, 3086 g L] e
And Do This: AutoFill a Series E v 28 g |
Select Cell D2 AND D3: both the 100 and | i 3 i [
the 105. Now you have selected enough ofa & 20 8 &
Range for Excel to recognize that this is a b |
Series, incrementing by 5s. [ a8 e |
B by e e [ ] m:
Double click the AutoFill handle and the &~
Series will fill down to match Column C on o | D2 A Je 100
the left. !
A . E . C D E .
What Do You See? When you AutoFill this .
Series, Microsoft Excel adds 5 more to the 1 |Date Product Net Quantity Revenue
quantity in each Row. 2 July 1, 2013 Eggs 5 150 100|
3 July 2, 2013 Eggs 5 150 105.
4 | July3,2013 Eggs 5 150 =
5 | July4,2013 Eggs 5 150 s
6 | July5,2013 Eggs 5 150
7 | Julys, 2013 Eggs 5 150

Exam 77-420 Microsoft Excel 2013
2. Create Cells and Ranges
2.1 Insert Data In Cells and Ranges: Autofill
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=C2*D2
D E F

Ong

@ H%

Calculate Revenue B e Mo e

Labels and Data. Now all we need are the e 7

formulas. Think about the math: revenue equals osser e B

net times quantity. d  EI

Try This: Create a Formula e

Select Cell E2 and type in the equal sign. ETTr=mmn

All good equations begin with “=.” B i san s

Select Cell C2—the Net is $1.50. oo

Type the times symbol (the asterisk key). B aiscis

Select Cell D2—the Quantity is 100. i f.‘:'ru',{u: :

The completed equation is =C2*D2 . :;:E:E ;

Hit the Enter key on your keyboard. Excel won't & winmue -

calculate until you leave the Cell. T

What Do You See? There it is. $1.50 times 100 D2 - x N =

equals $150.00. OK, go to Cell E2 and double

click on the AutoFill handle to fill in the A B C

equations. [ [ [ .

. 1 Date Product l Met .ﬂuantlg: _Rwenue

Keep going, please... zJ July 1, 2013 Eggs l S 1.50 !
3 | July2,2013 Eggs 5 150
4 | luly 3, 2013 Eggs 5 150
5 | July4, 2013 Eggs 5 150
6 | July5, 2013 Eggs 5 150
7 | luly 8, 2013 Eggs 5 150

Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions
4.2 Summarize Data with Functions: Calculate Revenue
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T
onre Home ->Editing->AutoSum
fd % ' Booa - Aue - a W
AutoSum the Total Sales W [ = s s we e _ e
What is the sum of all the products sold? e : il et
Here are the steps to calculate the total Gotaws 4 Fomi Sapmaers —— o toans -
sales. [ Sl R v £ | g -
& L] 3 e - 0 L] H ' ] L] L " H ) " & " § ¥
P T
Try it: AutoSum the Revenue TR
Select Cell E25 ol i 5 L dmm
Go to Home ->Editing->AutoSum. e e
S| Ay 1A 3D Lpp 3 1w 1 5 AT
Ay 18 B s ] 1% e
Excel will enter the formula: B et 3 i i fae
=SUM(E2:E24) Suams 2 mim
| Suby 19, J0EN g $ 1w I 5 0008
. 2F  Ady M, R ek 3 1w ¥ 4T
Click ENTER on your keyboard. & 22| July 29, 2013 Eggs $ 1.50 200 $ 300.00
What Do You See? In the example on ;-: 23 | July 30, 2013 Eggs $ 150 205 $307.50
this page the Sum is $5,347.50. = 24 | July 31, 2013 Eggs 5 150 2101 5315.00 1
' —SUM(E2:£24)
5UM(number1, [number?], ...)
July 26, 2013 Eggs 5 150 195 5§ 292,50
July 29, 2013 Eggs 5 150 200 5 300.00
July 30, 2013 Eggs 5 150 205 5 307.50
July 31, 2013 Eggs 5 150 210 5 315.00
| 55,347.50 _l

Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions
4.2 Summarize Data with Functions: SUM
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E 1

Takg 9| July 24, 2013 Emac & 150
One 20| July25,2013E  Insert.
21| July 26,2013 E X Delete
Copy the Spreadsheet 22| July 29,2013 E Rename
OK, that takes care of the eggs. Let's name = -
the spreadsheet and move on. 25| uly 30, 2013 E Move or Copy... 2
24 | July 31, 2013 E = View Cod
1. Rename the Spreadsheet ZEI Ql Jewiode
_Il?oubltlezclick the Sheet1 tab. 26 E. ProtectSl 15 July 19, B8
ype: Eggs 1 —
27 Tab Colo| 17 | July 22,
2. Copy the Spreadsheet o | _ 18| July 23, ‘ |
Right mouse click the “Eggs” label. 2 Hide Y :_M:e szem}d s
Select Move or Copy. 29 | e 19 | July 24, § To boo
Check C 30 =19 50 | July 25, |Booki
3. Check Create a copy. e .
Click OK to close the Move or Copy window. 1 Egas gii:;g 21| July 26,8 Before sheet:
22 | July 29, a4
4. What Do You See? There should be a . 23— Julv 30 Sheet2
new sheet called Eggs (2). 3 | July U, | imove to end)
24 | July 31,
Memo to Self: This method copied 'A EI
everything: labels, data, and formulas. : 26
Saves time, doesn't it? =
{ 27]
28|
28 29
29 p—
30 S
n4 4 > Eggs | Sheet2 | )
1 Eggs (2) | Eggs | Sheet2 | )

Exam 77-420 Microsoft Excel 2013
1. Create and Manage Worksheets and Workbooks
1.1 Create Worksheets and Workbooks: Copy and Move Worksheets
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Change the Variables

Next Step: Change a few variables, please.

Rename the Spreadsheet
Double click on the tab for Eggs (2).
Rename this spreadsheet: Legs.

Update the product data
Go to Cell B2 and change Eggs to Legs.
AutoFill Cell B2 to the bottom of Column B.

Change the Net
The net for chicken legs is 3.25.
Enter that amount and AutoFill.

Change the Quantity

The quantity starts at 50 and adds 5 per day.
In Cell D2 type: 50.

In Cell D3 type: 55.

Select D2 and D3 and AutoFill.

The work on the Pig’s page is similar. Copy the Eggs
sheet. Rename the new Eggs(2) sheet to Pigs.
Change the product to Pigs.

The Net is 4.75 and the quantity starts at 200 but only
adds one more per day.

NI T Er I L

=l T W e W R =

=l o W B W =

Intermediate Microsoft Excel 2013 Page 26 of 245

T T P o ) T i
CHEEERS 0 Dhipuncoms - | § - » |2 2| Contit e 8 | et e e S
‘ ""‘“L‘.,T“."::’“ P : wlw o | . s
A B C D E F
Date Product Net Quantity Revenue
July 1, 2013 Legs 5 3.25 50| 5 162.50
July 2, 2013 Legs 5 3.25 55| 5 178.75
July 3, 2013 Legs 5 3.25 60| 5 195.00
July 4, 2013 Legs 5 3.25 65| 5 211.25
July 5, 2013 Legs $ 3.25 70| $ 227.50
July 8, 2013 Legs §  3.25 75| $ 243.75
Date Product Net Quantity Revenue
July 1, 2013 Pigs 5 4.75 2000 5 950.00
July 2, 2013 Pigs § 475 201| 5 954.75
July 3, 2013 Pigs 5 4.75 202| 5 959.50
July 4, 2013 Pigs § 475 203| 5 964.25
July 5, 2013 Pigs 5 4.75 204| 5 969.00
July 8, 2013 Pigs $ 475 205| 5 973.75



Ta
O,,:° Home ->Cells ->Format ->AutoFit Column Width
ME %S oot - F W - &N
AutoFit the Columns e e e
What Do You See? Column E may display  #= .7 a:u. - = 4. | Elbptoie | § % 21 Gttt G | o T e o
#H#HHE. Why are there pound signs? That's Osees tom . srpae U S wn__ : P
Excel’s way of saying that the column is CI e T ':E'lx :H:j 2 AutoSum - Av
tOO narrow. ) & : ] t”l ] L " (-] Cl 1 (] K L ('] = (-} EEI ) Z
R sl Fill -
i hmeg 3 ani| e Delete Format Sort 8
The Computer Mama sez that means you & Siheiie  + on oo e = o & Clear~ Filter -
have too much money. B e
y E .':u.xu:: E an :'.s . Cells Cell Size
Ay 21, K'.I-N\ LY Fe
Try it: Format the Column Width T 1L Row Height...
Select Column E. B, — | _ _
Go to Home->Cells-> Format. i coRS0Ne. 13 AT MY m— AutoFit Row Height
g . 2
Select AutoFit Column Width. :I D; Column Width..
o
Here's another way: = - AutoFit Column Width
Place your cursor between the E and F - . " _
Column header—right on the line. Your \ - Default Width..,

cursor will change from a white plus sign to
a black double-headed arrow. Double click
and Column E will be resized as wide as it
needs to be.

Visibility
Hide & Unhide r

4.75 219 {HHARRHG

21| July 26, 2013 Pigs $

2| July 29, 2013 Pigs § 475 200 s
23| July 30,2013 Pigs § 475 221 s
24| July 31,2013 Pigs § 475 202 s
25| [ e
26

Exam 77-420 Microsoft Excel 2013
1. Create and Manage Worksheets and Workbooks
1.3 Format Worksheets and Workbooks: Adjust Row Height and Column Width
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Create a Summary Sheet

1. Make a copy of the “Eggs” spreadsheet
Right Click the Eggs Tab.

Select Move or Copy.

When the little Options window pops up,
Check to Create a copy.

2. Rename the Spreadsheet
Double click the tab.
Type: Summary

3. Edit the Data
Select Cell B2 and type: All Products.
AutofFill Cell B2.

Keep going, please...

3

T T B VSR P it EI Y.

12 | July 15, 2013 Eggs $ 1.50 150 4 27500
13 | July 16, 2013 Eggs $ 150 Insert...
14 | July 17, 2013 Eggs $ 150 B Delete
15 | July 18, 2013 Eggs S 150 Rename
16 | July 19, 2013 Eggs $ 150 Ty
17 | July 22, 2013 Eggs S 150 _
18| July 23, 2013 Eggs § 150 Q1 View Code
19| July 24, 2013 Eggs ¢ 1.50 [l Protect Sheet..
20| July 25, 2013 Eggs $ 150 Tab Color g
21| July 26, 2013 Eggs $ 150 Hide
22 | July29 "n13/cggs $ 150 o
23| July 3 1g5 $ 150
nal sn.a —— A ara Select All Sheets
1 15 | Legs | Eggs | shee | N,
BT EE R o
21| July 26,2013 All Products $  1.50 195 $ 292.50
July 29, 2013 All Products $  1.50 200 $ 300.00
July 30, 2013 All Products (&5 1.50 205 $ 307.50

L .. LT N .Y

i b Summary | Pigs | Legs | Eggs | Sheet2 |
| A | B . c b E |
1 Date Product Net Quantity Revenue
2 July 1, 2013|AII Pmducts_l 5 1.50 100 5 150.00
3 July 2, 2013 All Products & 1.50 105 5 157.50
4 July 3, 2013 All Products 5§ 1.50 110 $ 165.00

Exam 77-420 Microsoft Excel 2013
1. Create and Manage Worksheets and Workbooks
1.1 Create Worksheets and Workbooks: Copy and Move Worksheets
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T
O,::D Home ->Cells -> Delete ->Delete Sheet Columns
@B E % ot st W - A X

Create a Summary Sheet, cont. T = = s o o e o L i e a R
4. Delete Column C and D b ,.:_:_.__ B0 &4 A Elegetitose - | 5-% + |95 ;-:,: 'ﬁ_‘- ‘:}' et ﬁl:b"m ?:':_ E-_'\ L-:"l
Select Column C and D. Dotas am . snpraent W s n o S Gue g
Go to Home->Cells->Delete. a - K | S 4
Click on Delete Sheet Columns. A T e e Y Lt

by 1, Tk AN Peadicty
bty L. TOUB A Poodutts
baby L JELh A Peadadty
bty 4. J0UN AN Peaducty
Py L, B A Pepbatts
sl i, 20N AN Pecdact
Pty %, 20UH AN Penhtts
Ay 10, JOTE AN PedaTL
Sy 11, 041 AN Feaduchs

What Do You See? The equations in the Revenue
column now read: #REF!. The equation doesn’t have
the data for Net and Quantity anymore. It has nothing
to reference, hence the error message.

= N ]| 2 dy

o A et nse e Forma o in
ST Insert  Delete F t - Sort & Find &
) Pty 1, 0N A0 Tecbtts Ll Clear = 1
Go ahead: select those cells and hit the delete key to B 0 T 7 Filter > Select ~
i u, s A = (= n) .

clear the busted equations. e e g7 Delete Cells... liting

By L. 0UN AN Peoderty

4, JOuR AN Pepdenty 1 a — — —

::::."1..“-1‘.{;‘:!1-;&.:1'. _,_K L'elele sNeel hows

By T, TOUN AN Pegeberts

sy 1, 1R AN Pacderin Ld

Delete Sheet Columns

By MO DU AN Peodurts

B e B
IREEHEEEREEEERRREERERLS

MU EIESECE g e m e w e,

—_— —— B Delete Sheet
c2 v * A =#REF ! *#REF!
A A | B | C | D E F

1 |Date Product Revenue
i I

| 2| July1,2013 AllProdts | #REF! |
3 July 2, 2013 All Products H#REF!
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The Grand Total, cont. IF i X v K| = )
This equation will link the Summary sheet
a8 e oo e | 1

to each of the product sheets: Legs, Eggs,
and Pigs.
Date Product Revenue
Try it: Create reference links July 1, 2013 All Product5|=
3

h

—

1. Start on the Summary Sheet i
Select Cell G2 type: =. July 2, 2013 All Products

All good equations begin with "="

E2 i | X  Jf | =legslE2
2. Go to the Legs sheet
Select Cell E2. A A | E | C | D | E |
Type + (to add the next variable) 1 |Date Product Net Quantity Revenue
¢ 16250 1
3. Go to the Eggs sheet 2 July 1,2013 Legs $ 325 50{_5__1_63.;'5(_“
Select Cell E2. 3 July 2, 2013 Legs 5 3.25 55 5 178.75
Type + (to add the next variable)
Keep going, please... E2 v i X « fo | =legslE2+Eggs!E)
A A B c b E l
1 |Date Product Net Quantity Revenue
2 | July1,2013 Eggs $ 150 1001 $_150.00 |
3 July 2, 2013 Eggs $ 150 105 § 157.50

Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions
4.1 Apply Cell Ranges and References In Formulas and Functions: Reference Cell Ranges in Formulas
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:1 The Grand Total, cont. E2 i X [ -=legs!E2+Eggs!E2+Pigs!E)
4. Lastly, go to the Pigs sheet 4
Select Cell E2 ‘I A | B | C | D | E | F
Hit Enter on your keyboard... -

1 Date Product Net Quantity Revenue
————————— 1

5. You will be taken back to Cell C2inthe 2 | July 1, 2013 Pigs 5 475 200] $ _ 950.00 1
Summary spreadsheet. 3 | July2, 2013 Pigs $ 475 201 $ 954.75

6. AutoFill this equation and you've got a

formula that adds all of the sales for each : .
| : o = IE2+ IE2+ !
oroduct. Well done, c2 N Legs!E2+Eggs!E2+Pigs!E2 5

What Do You See? The formula says: 4| A | B | c | o L E L F [
=Spreadsheet!Cell 1 |Date Product Revenue

where Legs, Eggs, and Pigs are the names 2 July 1, 2013 All Pmduct_r.l $1,262.50 I

of our spreadsheets. u
3 July 2, 2013 All Products  $1,291.00

We linked several spreadsheets together

to Sum up sales in one place. 23| July 30,2013 All Products $ 1,861.00

Way cool. This is a good place for a 24 | July 31, 2013 All Products S 1,889.50

Cookie Break. Save your work and takea 25 | $36,248.00 I
few minutes off. w

i Summary | Legs | Eggs | Pigs | Sheet2 |

Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions
4.1 Apply Cell Ranges and References In Formulas and Functions: Reference Cell Ranges in Formulas
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Cell References

When you created the sales spreadsheet, you selected a range of cells to AutoFill. If we put 100 for the quantity in the first
cell and 105 in the next, Excel fills down the series and adds 5 more to each cell. If you wanted a different forecast you could
enter new quantities in the first and second cells and use the AutoFill again. This could get old very fast. It is also a rather
inflexible method of changing the data. There is a better method: reference cells.Reference cells set up one place to enter
the data. All of the other equations and spreadsheets that depend on that data look it up in the reference cells.

H % Boud - sanl s M
e ST PadiLEete®  Bomankl B WEW wie Thiae R
< Com T I vy Fam - E & = b fg] | Edemtem - Ao 44
o Pty | T A . wgeliCosas < | 5 - W 0 ,..,...-,:: fomsim ob | et e fomat =it e Frth
LR el AREaEY - Ll ¥ Ly
1
A L} € B ¥ @ - L3 L e n (-] L ] s ! T
Date Prokal Nl ity Revesss:
by 1, 3040 Gggn $ 1w i)
bty 1. 7008 Lpgs LR p)
boly 1, 3000 g $ 14 1%
by 4. TOAN g 5 1w 1
bty 3, 05 gt LT 1
raly I, 3081 Giggn E R i
bty 3. JH Lpp 3 1m 1.
sy 18, 20
sy 11, 304
by 12, 2% - 0 f
bl i | D2 : x 100
B| mobyin e
by 11, 2

fuby 10, 308

A E = D E F

Date Product Net ﬂ:uantiﬂ Revenue
July 1, 2013 Eggs $ 150 100
July 2, 2013 Eggs $ 1.50 105|
| July 3, 2013 Eggs $ 150 =
| July4,2013 Eggs $ 150 s
| Julys, 2013 Eggs $ 150
| July 8, 2013 Eggs $ 1.50

Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions
4.1 Apply Cell Ranges and References In Formulas and Functions: Reference Cell Ranges in Formulas
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Create the Reference Cells
Before You Begin: Go to the Pigs sheet.
Please select Row 1 and Insert four more
Rows. This will give us room to work.

1. Try This: Enter the Labels
In Cell A1 type: Price

In Cell A2 type: Start

In Cell A3 type: Increment

If these are Labels (yep, they are) then select
Cells A1:A3 and format the Font Bold.
Go to Home->Font->Bold.

OK, Now Try This: Enter the Data
n Cell B1 type: 3.25.
Format Cell B1 for Accounting.

Keep going, please...

Memo to Self: This lesson continues with the
Legs Eggs and Pigs.xlIsx spreadsheet

Home->Cells ->Insert

@EH % Bosd - lsael T o

Foad | BGINT  RASILIRSE  GOMALAL BN EhEW e Iadbarh bk
B "";“' Cot W -] K B % | Bwwte Brie K i = ﬁﬂ . 'p- 5:""" -l

i ) : -
- [ I = - S B0 | Elopetitoe + | § - % v [ 8 | ool s Cob [ e Pt | ey

) el arpa. . s 3 n g [

LH - & —
i A L] (4 L] i ¥ L] H i ') L] b L) ]
1l
]
1
i
3 et (uantity Reverss ‘m| —¥|
‘  oam M4 wam = E& 2 AutoSur
L F AW Wi § AR
] oam P ] EE EE' FI”'
L] $ am ¥E§ wWaln
] §am| i wmem Insert Delete Format
" ¥ an =4 wn A
£ § AW T - - - Ll Clear =
n| » 4 am | 8 wan
sl 4 t am T ]
" $4m w5 mn E'I' Insert Cells
LI $ an i Wmm - =
i 3 oAl HL § Loem 1
- t am mz § Loenm
= gt iwin €= Insert Sheet Rows
2| 1 $am L | utu |
1] 3 an 15k § 30008 n
a i oam m E

Exam 77-420 Microsoft Excel 2013
1. Create and Manage Worksheets and Workbooks
1.3 Format Worksheets and Workbooks: Insert and Delete Columns and Rows

§ ) J Q Insert Sheet

- x
A B | C [ = [ = [

Price 3.25_'

Start

Increment

Date Product Net Quantity Revenue
July 1, 2013 Pigs $ 475 200 $ 950.00
July 2, 2013 Pigs S 475 201 $ 954.75
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Create a Relative Reference - e o

2. Try This, Too: Create a Relative Reference
All good equations begin with "equals."

Select Cell C6 and type: =

Click on Cell B1.

Type: ENTER on the keyboard.

What Do You See? The formula in Cell C6 says that C6
equals B1. If you change the number in Cell B1, it
should automatically update in Cell C6.

Test Your Formula: Change the Data
Select Cell B1 and type: 4.75

Type: ENTER on the keyboard.

Select Cell B1 and type: 3.25

Type: ENTER on the keyboard.

What Else Do You See? The number in Cell C6 should ; i i

update as soon as you hit the ENTER key. 1 |Price . 3.251
2 |Start

The other Cells in Column C will NOT update at this 3 Increment

time: those Cells do not have a formula, yet. 1 1

Keep going... 5 Date Product Net Quantity Revenue
[ July 1, 2013 Pigs | =B1 200 5 950.00
7 | July 2, 2013 Pigs 5 475 201 5§ 954.75
8 July 3, 2013 Pigs 5 475 202 5 959.50

Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions
4.1 Apply Cell Ranges and References In Formulas and Functions: Use References (Relative, Mixed, Absolute)
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Autofill a Relative Reference

In the previous page we created an equation in Cell C6
and tested it. Please Autofill that equation to all of the
dates in Column C.

3. Try This: Autofill a Relative Reference
Select Cell C6. Double Click the AutoFill handle in the
lower right corner of the Cell.

What Do You See? The formula in Cell C6 will be
copied to all of the dates in Column C. However, instead
of copying $3.25, the price in Cell B1, Cell C10 says

ZIEEEZBemue-

| i
"Product" and Cell C11 says "Pigs." &l oal| Ch - I =B1
What Else Do You See? The numbers in Column E : A B C D E F :
also indicate a problem. The first equation in Cell E6 - :
calculates correctly. H 1 |Price 3.25 “
2 |Start
#VALUE means the data doesn't make any sense: there
may be a mismatch. In this example, Excel can't 3 |Increment
multiply Pigs*205 (Text times a Number). 4
Keep going... 5 |Date Product MNet Quantity Revenue
6 July 1, 2013 Pigs 5 3.25 200 5 650.00
7 July 2, 2013 Pigs 5 - 201 5 -
8 July 3, 2013 Pigs 5 - 202 5 -
9 July 4, 2013 Pigs 5 - 203 5 -
10| July 5, 2013 Pigs Product 204' H#VALUE!

Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions
4.1 Apply Cell Ranges and References in Formulas and Functions: Use References (Relative, Mixed, Absolute)

Intermediate Microsoft Excel 2013 Page 35 of 245



[:]
Onyg

Review the Relative References
You can double click any Cell that has a formula and see an outline of
the Cell (s) that are used in that equation.

Let's audit this spreadsheet.

4. Try This: Audit a Relative Reference
Double Click Cell C6. You should see the formula displayed in the
Formula Bar at the top of the spreadsheet. Cell B1 is outlined in Blue.

Double Click Cell C10. Cell B5 is outlined.

What Does That Mean? The formula in Cell C6 was =B1.
Instead of copying $3.25, the formula (=B1) was AutoFilled.

What Else Do You See? When the formula in Cell C6 was AutoFilled,
the Cell Reference was updated for each Row.

This is an example of a Relative Cell Reference. It is Relative
because it was updated for each Row.

Keep going...

Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions

IF v xX v K =B1
A C D | E -
1 |Price 3.25
2 |start 4
3 |Increment
4 a
5 Date Product Net Quantity Revenue
[ July 1, 2013 Pigs |=Eii 200 5 650.00
7 | July2,2013 Pigs s - | 201 $ -
IF v X  J || =B5
A C D] E F
1 |Price 3.25
2 |Start
3 |Increment
4 W
5 |Date lPrﬂduct _| Net Quantity Revenue
6 | July1,2013 Pigs $ 3.25 200 $  650.00
7 | July2, 2013 Pigs s - 201 $ -
8 | July3, 2013 Pigs s - 202 $ :
9 | Julya, 2013 Pigs s - 203 $ -
10 July 5, 2013 Pigs |=35 204 #VALUE!
11| July8, 2013 Pigs pigs 205" #VALUE!

4.1 Apply Cell Ranges and References in Formulas and Functions: Use References (Relative, Mixed, Absolute)
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Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions

Take o T " e
Oﬂ. - « SN PAM LI AGRMALML Bl VW e Dhsbans. st ‘
e il
Create an Absolute Reference s s e - -
There is another way to manage copying formulas so . X : " X~ = ’ . . o N AW 5
that they point to the right data. o — — : '
An Absolute Reference is defined as a specific Row | . e e i s
or Column. The Absolute Reference will NOT update if '*! NEpenabal
it is copied to another Row with Autofill. | mamore s om || IF - X o f =4B51
Bl mimre 5 an
5. Try This: Create an Absolute Reference i samare ¢ an
Select Cell C6. foame A | - - =
Click your cursor in the Formula Bar on B1. % s 5 sm | 1 |Price |_ 3.251
. A7y id, 3650 4 B —
On your keyboard, click on F4. % s 3as | 3 _Start
» (L s ] $ 1
What Do You See? The formula in Cell C6 is now: 1 J:' o 3 |Increment
=$B$1, where the dollar $ sign means that it is D wynzorg 5 an  (Sy
Absolute. : Sy b - ——— .
5 |Date Product Net Quantity Revenue
Try This Too: AutoFill the Absolute Reference EJ July 1, 2013 Pigs |:$B$1 200 5 650.00
Select Cell C6. . *
Double click the Autofill handie. 7| July 2, 2013 Pigs $ 3.2 201 5 653.25
It looks like it worked this time. 25 | July 26, 2013 Pigs S 3.25 219 $ 71175
Keep going 26 | July 29, 2013 Pigs 5 3.25 220 5 715.00
27 | July 30, 2013 Pigs 5 3.25 221 5 T18.25
28| July 31, 2013 Pigs 222 5 72150
29 | 515,772.25
4 Summary | Legs | Eggs | Pigs Sheet2 *

4.1 Apply Cell Ranges and References in Formulas and Functions: Use References (Relative, Mixed, Absolute)
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Using Reference Cells e B2 i X v & | =B2
The next task is to calculate the daily sales. In this ¥ o £
example, we will make one Cell Reference in the I A B C D E
formula Relative and the other Absolute. | — - | - : !
- I — 1 |Price il 3.25_
Before You Begin: Edit the Data . e 3 .2 2 |Start E 1 !
In Cell B2 type: 100 o memire 15 3 |Increment 5
In Cell B3 type: 5 B eamees 1t 18 x|
Thoughts to Consider - T.uim’l : .u 5 |Date Product Net Quantity Revenue
Cell D7 should be whatever we sold on the first day, ~ @ =iz @ o= LE _g > 3 L 2 :
plus the quantity we are forecasting for each day’s » sam T | iH'V 2, 2013 Pigs 5 335 201 5 653.25
sales increment. ] = : : ;,:
6. Try it: Create the Formulas D7 - : > v Je =DE+E3
Select Cell D6 and enter this equation:
=82 A | 8 | ¢ b E |
Select Cell D7, and enter this equation: Price 3.25
=D6 +B3 |start 100
Try This, Too: AutoFill the Formula |Increment | 5l
Select Cell D7 and double click the AutoFill handle
to fill down the formula. Keep going... ] .
| Date Product Met .{lua ntly .Revenue
July 1, 2013 Pigs $ 3.25 100 § 325.00
July 2, 2013 Pigs 5 3.25 =D6+B3| & 653.25
July 3, 2013 Pigs $ 3.25 202 § 656.50

Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions
4.1 Apply Cell Ranges and References in Formulas and Functions: Use References (Relative, Mixed, Absolute)
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Troubleshoot the Formulas S o — - -
7. What Do You See? The #Value! means that there X - _’ hd . AL : L e e

is an error. Please audit the spreadsheet. Double click s

on Cell D9. Excel highlights the cells in this formula:  — .
- et wavg 3 ™
How Did That Happen? Part of the formula is still C ETETC T
correct. It equals yesterday’s sales—the Cell B et 3 a
above—and adds to it. P
Most formulas automatically use Relative i iy 2 i
References. A Relative Reference adjusts the the cell = |
references when you copy or fill it down. ¥
& + i X ¥ k| =D8+B5
In our example, =D8+B5 becomes =D9+B6 in the &
next Row down. A | B | C D E
In Cell D9, the formula adds a number to a label. L - Price 325
Hence, the error #Value! 2 |Start 100
3 |Increment 5
4 — —_—g
5 |Date leduct l Net Quantity Revenue
6 | Julyl,2013 Pigs 5 3.25 100 5 325.00
7 July 2, 2013 Pigs 5 3.25 ! 1{]5. 5 34125
8 July 3, 2013 Pigs 5 3.25 105| 5 341.25
9J July 4, 2013 Pigs 5 3.25 |=D&+B5 HALUE!
10| July 5, 2013 Pigs 5 3.25 #VALUE! #VALUE!

Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions
4.1 Apply Cell Ranges and References In Formulas and Functions: Troubleshoot a formula
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Absolute References

When you need to work with one particular cell you
need an Absolute Reference.

8. Try it: Create an Absolute Reference
Select Cell D7.

The Formula bar shows =D6+B3.

Go to the Formula Bar and click on B3.

Click the F4 function key on the top row of the
keyboard.

Fuby 10, 2003 P
sy 11, 3081 gy
fuly L1, 3043 Fign
by 13, 2558 MY

What Do You See? The cell reference becomes
$B$3. This means "go to B3 only, and no place else,"
to get the data.

Try This, Too: AutoFill the Formula
Select Cell D7 and AutoFill the revised equation to
the rest of the rows.

A Mixed Reference uses Absolute and Relative cell
references.

Exam 77-420 Microsoft Excel 2013
4. Apply Formulas and Functions

v X « Jx || =D6+5B53
A . o c D E
Price 3.25
start 100
| | | |
Increment | 5]
| | |
Date Product MNet _ﬂuantlﬂ _Revenue
July 1, 2013 Pigs $ 3.25 100] § 325.00
July 2, 2013 Pigs ¢ 2.25 |-De+¢BS2| ¢ 34125
July 3, 2013 Pigs $ 3.25 105 § 34125
July 4, 2013 Pigs $ 3.25 #VALUE! #VALUE!
July 5, 2013 Pigs $ 3.25 #VALUE! #VALUE!

4.1 Apply Cell Ranges and References in Formulas and Functions: Troubleshoot a formula
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Audit Your Work

You can double click on a cell to trace the
references in the formula. Here is a better

way to audit your spreadsheet.

1. Try This: Trace the Dependants

Select Cell B3.

Go to Formulas->Formula Auditing.

Click on Trace Dependents.

What Do You See? There are some
useful tools for Formula Auditing:

Oy

+ - 0O
5" | Trace Precedents

Finds the cells that have an affect on the

cell you selected

o "E

“5 Trace Dependents

Locates the formulas that use this cell in 4

their equations

E‘ Remove Arrows

Keep going...

Formulas -> Formula Auditing->Trace Dependents

BE s ' oot - tnl
| e T 1 T e

AT REBEIBRE B oS

3 e Drpevalents. <) fvsr Chnk
iaed | Acoloem Rarelly feaecisl ogasl Tod Dele Gosleph Vb S Mo | N e 5
Fucties r Gl v . = Temge Rebpcr s Tage Fensteen- | Mamage 1 Conte b Setecnan | 1 Bamares desin © (K st Fix

[t

Eevasa nama e

Bl = ) & 13

i ¥ 8 " ' ¥ x L -

Bt Fmcebents 5] S b E:“ Trace Precedents @Show 1

=] .
=it Trace Dependents ¥4 Error

- A x

-

= R.‘ Remove Arrows - (—E‘ Evaluate Formula

Formula Auditing

] w3
? iS5 MLE
1] 1% 3 wWw
L] i i N
L] 10 5 Bl
n s 4 aan
L] i § a3k
L] 1m 5 amm
LI
L]
. B3 - x B || 5
L]
i
i » A | B | C | o E
o .
aal Price 3.25
2 |Start 100

i:l Increment

53 |Date

6 | July1,2013 Pigs 100
7 | luly2,2013 Pigs 105
8 | luly3,2013 Pigs 110
9 | luly4,2013 Pigs 115
10| July5, 2013 Pigs 120

Exam 77-427 Microsoft Excel 2013 EXPERT
1. Manage and Share Workbooks
1.3 Manage Workbook Changes: Troubleshoot With Tracing (Trace Dependents)
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T
o::’ Formulas -> Formula Auditing->Trace Precedents
WE s o oo’ -t E:E' Trace Precedents @ Show Formulas
mgm ﬁ - ] erdnt Al Larced somanxl tats W e
Formula AUdltlng [ - I - ERE B | Seemas s | i e ﬂiE Trace Dependents Y1 Error Checking -
2. Try it: Trace Precedents |t ety e Yot b gk h M | M o T Bt .
Select Cell E29. . ' Fecrse Ly sresaninn tom B( Remove Arrows ~ (Jx) Evaluate Formula
Go to Formulas->Formula Auditing. o o AL F Ia Auditi
Click Trace Precedents. Youwillseean .= "o = " = T 0T n o n o m et ormiia AUeing
arrow from Cell E6 to Cell E29. e
o= A 1 B | & 1 D | E -
Click Trace Precedents again. X 1 |Price 3.25 2
You should see arrows in each Row that " B
trace the formulas. i : 2 |Start 100
R 3 |Increment 5
Click Trace Precedents a third time. w 4_
You will see a call out to each variable in » . .
Cells B1, B2 and B3. 3 |Date Product Net Quantity Revenue
= liahir 1 29012 Dioc Cm R - T A NN
. \.l'_ July Ly ETLa T IEJ o P Ty e ERELE o [ L
Please click on Remove Arrows to take o July 2, 2013 Pigs 3353959  341.25 ‘

off the tracings.

325.00
341.25

Exam 77-427 Microsoft Excel 2013 EXPERT
1. Manage and Share Workbooks
1.3 Manage Workbook Changes: Troubleshoot With Tracing (Trace Precendents)
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r
o;:" Formulas -> Formula Auditing->Trace Precedents
@ H - —— - T
. | I T T T =
Tracing Errors A IS BB B OB [ [ o e Btmeess see| %29 Trace Precedents (%] Show Formulas
What Does an Error Look Like? Here is a ot i by Fr el o (e g MR Mo | M i) y .
simple example we can try. ) ' et s o2k Trace Dependents ™! Error Checking -
- 9 : BT - -:Mm! - RN B\ Remowve Arrows - '.?Et' Evaluate Formula
Before You Begin: Set Up a Mistake K e 2 o -
Select Cell E8 and type: 360 - — ) Formula Auditing
Now Cell E8 does NOT have a formula. Yet, & ow s st usony sovesss
how would you know? - b
B rara,sas hp
3 Try This: Trace the Precedents B s
Select Cell E29. | Pkt ) 3
Go to Formulas->Formula Auditing. 1| 12 20 E29 T f =SUM(E6:E28)
Click Trace Precedents. You will see an [l M 20

arrow from Cell E6 to Cell E29. e 25 21 P A ' B ' L ‘ D E F .
vamng  rememsf = 1 |Price 3.25
Click Trace Precedents again. =
. 2 |Start 100
What Do You See? You should see arrows 3 |Increment 5
in each Row that trace the formulas. You |
should see a "gap" in the tracings. This gap 4
indicates that there is no formula in Cell E8. 5 Date Product Net Quantity Revenue
Keep going.... 6 | July1,2013 Pigs —335—e—1060 325.00
7 | July2, 2013 Pigs 3351059 341.25
8 | July3,2013 Pigs S 3.25 110 § 360.00
9 | July4, 2013 Pigs P—335—e— 15 373.75
10 July 5, 2013 Pigs 3251269 390.00
11 July 8, 2013 Pigs 3251259 406.25

Exam 77-427 Microsoft Excel 2013 EXPERT
1. Manage and Share Workbooks
1.3 Manage Workbook Changes: Troubleshoot With Tracing (Trace Errors)
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BH s ' Bood® - sael ¥ 4 ®
“ HORA BAEET RS donanai Baia e i Disaners thcts + JIY
Show Formulas 5k S BB BRI B o o Do G D § 8o
Sometimes, it helps to loooook at the o |ttty Pt 1t O bk ah e | oD e b | | St G ot 4
formulas. Here are the steps: P— P T f— -
. & L] £ o ! ¥
Before You Begin: Remove the arrows i riee L E:ﬂ Trace Precedents E Show Formulas
1 bmarersesd L] (=] W .
. . ot Trace Dependents ! Error Checking -
4. Try it: Show Formulas s owr - - iy e “ P ; g
Select Cell ES. v = o coop 2. Remove Arrows ~ (%) Evaluate Formula
Go to Formulas->Formula Auditing. 1 s s e a5k <rm
. LR g Lrbe G5} =L iti
Click Show Formulas. i - e S [ecarcal Formula Auditing
BE A P g G ={EFE
B S — - — -
What Do You See? All of the cells that have = s " sy o= ~cusems
. o = I
formulas are displayed. Cell E8 has a e i
number that we typed in earlier in this . B
lesson: no formula. - e
L Cstigid]
=

You can click on Show Formulas, ag
turn off the formulas display.

ain, to

Exam 77-427 Microsoft Excel 2013 EXPERT
1. Manage and Share Workbooks

Quantity Revenue

=B2 =C6*D6

=DB+S$BS3 =C7*D7

=D7+3B%3 360 |
=D8+5B%3 =C9*D9

=D9+5B53 =C10*D10

=D10+5B53 =C11*D11

=D11+5B53 =C12*D12

1.3 Manage Workbook Changes: Troubleshoot With Tracing (Show Formulas)
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B H% ' ot - szl ¥ a =
A ﬁ MOA GAIRT A LIRS | onaasd BN VW e D it + Y
Error Checking _ A TOERCE B @ @ o
Error Checking works like Spell Checking. T e e s ey S
Errors can be marked and corrected one ata s Lasay
time, or Live, as you work on your formulas. - : : - . - u» D8 - * v fe —C7*D8
1. Before You Begin: Make a Mistake e °f
Select Cell E8. (PO S e i l l & | B E
Enter this formula: =C7*D8. o e i, % SN Price 3.25
B vz B —
ymam 1R w2 Istart 100
What Do You See? This formula does NOT & hiiie 1.5 =i o _
match the formula above or below it. So, Cell  iiiiie D02 i o 5 |Increment B
E8 has a error mark, a small triangle in the ... A i -
upper left comer. ;E E:EEE E EE :23 :; 5 |Date Product Net Quantity Revenue
i = | : = B July 1 2013 Pigs S 325 100 5 235.00
Keep going, please... 5 . ] | o — - -
X : 7 | July2,2013 Pigs l S 3.25 l 105, 341.25
: s] July 3, 2013 Pigs $ 3.25 ! 1101:c7*08
9 July 4, 2013 Pigs 5 3.25 115 § 373.75
7| July 2, 2013 Pigs 5 3.25 105 5 341.25
g July 3, 2013 Pigs 5 3.25 11ﬂlr$ 357.50
g July 4, 2013 Pigs 5 3.25 115 5 373.75
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Error Checking Options

2. Try This: Run Error Checking

Select Cell E8.

Go to Formulas -> Formula Auditing.
Go to Error Checking->Error Checking.

What Do You See? The Error Checker
found that the formula in Cell E8 is
inconsistent: it is not the same as the
formula in the Row above.

The Error Checking Options include:
Copy Formula from Above

Help on this error

Ignore Error

Edit in Formula Bar.

If you have a LOT of problems with your
formulas you can use the Previous and Next
buttons to navigate through your Error
Checking.

Keep going, please...

Formulas -> Formula Auditing->Error Checking

BE %S
B < s psesd | sohad B e W

Boad’ - dmw

Doy Hamma -

FE = & %

Dicasens ticts + Y

| e == %20 Trace Precedents Show Formul |—|:
fewmon | - lemd- - T B Ly~ hecten unq-:tm--,as—.u . [EEslrsgsr L @' oA =1
" - T —— =3% Trace Dependents | Errar Checking - WE' eh
ot A e v e L] W Remove Arrows v | Vi Error Checking... ow
s —— Forl 1 Trace Error
" 5 |Date Product Net Q | o o
! 6 | Julyl,?2013 Pigs S 3.25 s = TELIAT RETETENEES
S 7| July2,2013 Pigs S 325 105 $  341.25
i r
v 8 July 3, 2013 Pigs S 3.25 110| S 357.50 .l 2
; 9 | July4, 2013 Pigs S 3.25 115 § 373.75
. 10| July5, 2013 Pigs 5 325 120 S 390.00
w11
w12

13— Error in cell E3
l = | Copy Formula from Above

14 o

15— Inconsistent Formula Help on this error

1.5— The formula in this cell differs from the

= formulas in this area of the spreadsheet. Ignore Error

18: Edit in Formula Bar

- | orewous | | hen

20

21 uly 22, H1gs
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Error Checking Rules
Error Checking Rules can be found by
clicking on the Options button when you
are in the Error Checker.

3. Try This: Review the Options
The Error Checking is still open.
Click on Options.

What Do You See? Error Checking is
enabled by default.

The Error checking rules include:
Cells that result in an error
Inconsistent formulas in tables
Years that are only 2-digits
Numbers formatted as Text
Formulas which omit cells

Unlocked cells which have formulas
Formulas that refer to empty cells
Data that is invalid

Click OK to CLOSE the Error Checking
Options. Cell E8 still has an error. Click
Copy Formula from Above to fix it.

Then CLOSE the Error Checking window
to return to the spreadsheet.

Formulas -> Formula Auditing->Error Checking->Options

e a L et ' '
| e T LR ]

J,r - &l 71 a whated iz § 3 calndmon padformancs aad 8 [

fy o - P 4 - F.
Z B ER -
e el Bavenlly lnancsil ingesl Tred ha
Fanaman Ly Wi aok Caloubatinn i mabin o e .2 i = =
L] - £ | =T W dp— Mg bppgny 1R 5
Bebvmgher peagd Vee ks ey . o
a i 48
2 ' & & T Chamr B ¥

1 P )

B it g

] 5 W] it s

i

5 st Pt Bk Dusty e

8| iyl muE g i Lo w0 e

T | eyl Ml P F LB - 1 P i w— o iy

B by R i LD |'_3ﬂ o et P vl Pt e et T e

L] ray b, J0RE P i A ]

M| kely 3 OEEN Py ¥ L3 =

L1 o e ! iy kg 4 cPacing

o ~ s igrered e

| Peemeam Ieaflcgtn ey g By gl v

M B ] =

vy|  esmaetent Feemaiy E

w L ] G g Dy, gt el o g R LT

L

i) o e e s [ ey 8 o oy 0 { Dt prng P by

“ -

s | Error Checking

]

Enable background error checking

Indicate errors using this color Q -

Error checking rules

Cells containing formulas that result in an error i
Inconsistent calculated column formula in tables &0

Cells containing years represented as 2 digits &)

Reset [gnored Errors

Formulas which omit cells in a region (&
Unlocked cells containing formulas 2
[] Formulas referring to empty cells

Mumbers formatted as text or preceded by an apostrophe (0

Formulas inconsistent with other formulas in the region ()

Data entered in a table is invalid
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Summary

This lesson introduced Formulas and Formula
Auditing. The focus of each exercise was on the
Cell References. We looked at the differences
between Relative and Absolute Cell References.

Well, you done good.
You get the cookie. <grin>

0H% hewd - kn e P W o= A N
B e eoin et | G fain Wew  we Bt i - J
A ZEE BEE AR oI . B B s
e e B e s s = e | s e
F - L] 3 [ + ¥ Ll H L L3 L L L) a L3 a L} L] L} O
q ke L] (=1
 — et *.0 Trace Precedents EShow Farmulas
Bl e - o . -
¢t <t Trace Dependents ™! Error Checking
Eo :%E%EE I_'S’( Remove Arrows - @ Evaluate Formula
Bl k0 Formula Auditing
BE| Dy 16 TRUN P
By 13, mh
BE by LL IEEN Fyn
B Py 1 M
¥ .u-.-m:t:.l.pgq
| oy ic s - > &  J | =SUM(E6:E28)
B by 19, AN Py
EJ" .WN.N::I-P"'
B = 1 4 - | € L E . F
: 1 | Price 3.25
2 |Start 100
3 |Increment 3
4—
5 |Date Product Met Quantity Revenue
6 | Julyl,2013 Pigs —3.35—=—106 325.00
7 | July2, 2013 Pigs P—325—=—105 9 341.25
8 | July3,2013 Pigs 5 335 110| S 360.00
9 | July4, 2013 Pigs P—325—— 159 373.75
10| July5, 2013 Pigs —335—=—3126r 9 390.00
11 July B, 2013 Pigs 9—325—=—1251 9 406.25
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Practice Activities
Lesson 1: Legs, Eggs and Pigs

Before You Begin: Start Microsoft Excel. Open a new, blank spreadsheet.

Try This: Do the following steps

. Enter the following labels in Row 1, beginning with Cell A1: Date, Location, Sales, Profit. Format Row 1 as Bold.

. Select A2. Enter: January

. Select A2. Use the AutoFill command to fill January through December in Column A.

. Select B2. Enter the location as Ann Arbor. Use the AutoFill command to fill the location through December

. Select D2. Enter the formula for Profit. Profit is 25% of the Sales. Use the AutoFill to fill the Formula from D2:D13.

. Go to the bottom of Columns C and D, use the AutoSum command to find the total Sales and total Profit for the year.

. Copy Sheet 1 two times.

. Rename Sheet 1 to Ann Arbor.

. Rename Sheet 2 to Detroit. Change the Location to Detroit and AutoFill.

10. Rename Sheet 3 to Lansing. Change the Location to Lansing and AutoFill.

11. Adjust the column widths where necessary to fit the contents.

12. Go to the Ann Arbor sheet. Enter the sales for January as $10,000. Format the column to be Accounting. Enter the sales for
February as $11,000. AutoFill down. The increment is an increase of sales each month.

13. Go to the Detroit sheet. Insert 3 blank rows at the top of the sheet. Add labels in column A for Start and Increment. Enter the
value $15,000 for start. For increment enter 5,000. Enter the formula in the Sales. January is $15,000, the starting point. February
and beyond will be start plus increment. Create an Absolute Reference for the Increment. Use AutoFill and fill down.

14. Go to the Lansing sheet. Insert 3 blank rows at the top of the sheet. Add labels in column A for Start and Increment. Enter the
value $20,000 for start. For increment enter 110%. Enter the formula in the Sales. January is $20,000, the starting point. February
and beyond will be start times the increment. Create an Absolute Reference for the Increment. Use AutoFill and fill down.

15. Insert a new blank sheet in the workbook. Rename the sheet Totals.

16. Enter the following labels on the Totals sheet: Month, Sales, Profits

17. Enter January in Cell A2 and AutoFill through December.

18. Enter the formula for Sales to add the three locations (make sure you select January across all three sheets—remember that
Detroit and Lansing have the reference rows at the top.)

19. Use the AutoSum to add the total sales and total profit on the Totals sheet.

20. SAVE as YOUR NAME Legs Eggs and Pigs Practice.

OCOoONOOAWN-=-
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Test Yourself

1. Where is the command that formats
the Date & Time?

a. Insert Ribbon

b. Format Ribbon

c. Home Ribbon

d. Cells Ribbon

Tip: Intermediate Excel, page 16

2. AutoFill for dates is the same as Copy
and Paste.

a. True

b. False

Tip: Intermediate Excel, page 18

3. You can rename a sheet in Excel from
Sheet 1 to Eggs.

a. True

b. False

Tip: Intermediate Excel, page 25

4. What does it mean when Excel
displays #HH#H#H#?

a. The data doesn’t make sense (such as
adding text to numbers)

b. The column is too narrow

c. Nothing for the formula to reference
(such as a blank cell)

d. You made an error

e. Unspecified Error

Tip: Intermediate Excel, page 27

5. What does it mean when Excel
displays #REF!

a. The data doesn’t make sense (such as
adding text to numbers)

b. The column is too narrow

c. Nothing for the formula to reference
(such as a blank cell)

d. You made an error

e. Unspecified Error

Tip: Intermediate Excel, page 29

6. Which is NOT a valid formula?
a. =B1

b. B1

c. =B1*B3

d. =SUM(B1:B20)

Tip: Intermediate Excel, page 34

7. What does it mean when Excel displays
#VALUE ?

a. The data doesn’t make sense (such as
adding text to numbers)

b. The column is too narrow

c. Nothing for the formula to reference (such
as a blank cell)

d. You made an error

e. Unspecified Error

Tip: Intermediate Excel, page 35

8. Which is true about Relative & Absolute
References? (Select all correct answers)

a. When the fill command is used, a relative
reference updates each row to match the
new location

b. The F4 key turns a Relative Reference into
an Absolute Reference.

c. A mixed reference has both Relative and
Absolute References

d. $A%4 is an Absolute Reference

Tip: Intermediate Excel, page 37

9. Which command shows the formulas?
a. View-> Formulas-> Show

b. Formulas-> Formula Auditing-> Show
Formulas

c. Formulas-> Reveal Formulas

Tip: Intermediate Excel, page 44
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